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From The Chief Editor's Desk...
You and I both know that there are a lot of people who get caught up in "the numbers." We see it periodically when someone posts in the PCLinuxOS forum that PCLinuxOS fell two places in Distrowatch's "ranking." That "ranking" is a measurement of how many "hits" that distro's page has received in a day, averaged out.
For what it's worth, PCLinuxOS still sits in the top 20 of the top 100 distros, as ranked by "hits per day" on Distrowatch. PCLinuxOS, at the time I'm writing this article, is solidly ranked 16th in the Distrowatch HPD rankings.
I was around many years ago when PCLinuxOS actually (and briefly) held the number one rank for HPD on Distrowatch. It was somewhat chaotic, uncharacteristic for the calm that typically envelops the forum. Texstar and many others have stated they don't want to be the number one ranked Linux distro. It brings all the "weirdos" out from the woodwork. It makes you a target. After all, who does everyone aim for? Who does everyone look to "dethrone?" Of course, it's the "Big Guy" on top.
Numbers can also tell a lot about what's going on. Early on in my stint as the magazine's Chief Editor, I added download counters for the PDF, and a site visitor counter to each month's HTML entry page. That way, we could get an idea of how much the magazine was being read.
Over the years we've watched the numbers slowly fall, both with the number of downloads of the PDF, and with site visits on the magazine's HTML version. This past month (for the September issue), we saw the lowest numbers we've ever seen for downloads. By the month's end, it isn't/wasn't uncommon to see at least 1100 downloads of the PDF. But, by the end of September, we're barely over 800. Now 300 downloads, give or take, doesn't seem like that huge of a number. But that's over a 25% drop, compared to recent months.
For the few of us that work on producing this magazine every month, it raises some questions for us. Like, are we not writing interesting enough articles? What could/should we be doing differently? What are we doing that isn't liked? Or, has our readership numbers just fallen to such lower levels because fewer people are using PCLinuxOS? These are all valid questions, I think.
One of my guidelines on deciding what to write about every month goes something like this. First, cover PCLinuxOS first. Second, cover Linux. Third, cover computing and computing issues and advances. Fourth, cover things that PCLinuxOS/Linux users might find interesting. So, to that end, I do know that users of other distros do also read "our" magazine. I've heard it many times.
I mentioned it in a PCLOS-Talk channel chat with Meemaw, our Assistant Editor. She too admitted that she had really noticed the decreased download counts, as well. Neither of us can come up with a satisfactory explanation for the decrease.
We certainly hope that the number of PCLinuxOS users isn't dropping all that much. Some gains and losses are to be expected, after all. We all here at the magazine, and I'm sure that many of you out there, already know that PCLinuxOS is the BEST Linux distro in the Universe(s). The rest of the world just hasn't caught on or caught up. Shame on them! But then again, do we really want an "invasion" of our calm little corner of the Linux world?
We usually hear from the same regular readers when we release an issue of the magazine. But, if there is something you want to see more of, please let us know. We do have quite limited resources, but we will try to see what we can do to get the requested information to you. Even if that means learning it ourselves to a point where we can teach others (as we've done many times in the past). OR, write the article yourself and submit it to us! We are ALWAYS interested in original articles, especially if they come from within our own PCLinuxOS family.
********************
This month's cover celebrates Halloween, and was created by Meemaw.
********************
Until next month, I bid you peace, happiness, serenity, prosperity ... and continued good health!
PDF Part One: Creating The Universal Document
by Paul Arnote (parnote)
Way, way back in ancient computer times ... in this case, 30 years ago (1992) ... Adobe created the PDF file. The letters of the file extension stand for "Portable Document File." Up until that time, the sharing of documents was more difficult. There were various word processing programs around, and there was no guarantee that one word processor's files could be read by a different word processor. Plus, even then, not having the proper fonts installed on the "guest" system meant that the document might not display as it was intended.
Background
For all of its faults as a software company, Adobe did manage to create a truly portable document system that displayed properly on all systems. All you had to have was a reader capable of reading PDF files. Adobe also gave away the reader software, and for quite a while, it was just about the only reader available. The PDF format is based on the PostScript language (also developed by Adobe between 1982 and 1984), and each PDF file encapsulates a complete description of a fixed-layout flat document, including the text, fonts, vector graphics, raster images and other information needed to display it.
In 1993, Adobe made the specifications for the PDF file available free of charge. For the first 16 years, the PDF format remained a proprietary format, controlled by Adobe. And, I can remember Adobe vigorously and enthusiastically controlling the PDF format, to the point of discouraging other software vendors from producing PDFs or PDF readers. Then, in 2008, Adobe released the PDF format as an open standard, which coincided with the International Organization for Standards granting the open standard, as ISO 32000-1. In 2008, Adobe published a Public Patent License to ISO 32000-1 granting royalty-free rights for all patents owned by Adobe that are necessary to make, use, sell, and distribute PDF-compliant implementations, according to Wikipedia.
Fast forward to today, and the PDF document format has become the predominant de facto standard for documents. It can be read and used on just about every modern platform imaginable. Its use has been adopted throughout every corner of the computing world, from the distribution of official government forms to even this very magazine. Office suites, from Microsoft Office products to LibreOffice to Google Docs, offer document output as PDF files. The list of PDF readers is simply too long to list, with even the major web browsers (Firefox, Chrome, etc.) capable of displaying PDF files natively within the web browser.
PCLinuxOS users typically have several options for reading/viewing PDF files. KDE users have Okular, which is an excellent and a very adept reader/viewer for not only PDF files, but other document formats. Mate and Gnome users have Evince, which does an admirable job of faithfully displaying PDF files. Qpdfview is another PDF reader/viewer (and one that I use quite regularly), that stands out because of being very lightweight. Evince is a popular Gtk-based PDF reader. There are many, many more PDF readers/viewers available, and each have their devoted fans.
Creating PDF Files
When the PDF format was first released, only those who paid Adobe insane and obscene amounts of money for the PDF creation software were about the only ones who could create PDF files. However, since 2008 when the PDF format became an open standard, nearly anyone could then create PDF documents.
LibreOffice Writer ... 4th icon from left.
Scribus ... 7th icon from left.
Under LibreOffice, you can find the PDF Export icon on the toolbar (and in the File menu) of ALL of the programs that make up the LibreOffice suite. I just showed the toolbar from LibreOffice Writer above as an example. Even the copy of Microsoft Word and Excel that I sometimes use at work (I plead for mercy every time) can export its documents as PDF files.
Scribus (which is used to create The PCLinuxOS Magazine PDF every month) is a multiplatform desktop publishing tool, and its primary output is files in the PDF format.
Google Docs ... download your document as a PDF file
Even with the online office tools, like Google Docs, you can download your documents in the PDF format.
CUPS-PDF print dialog
Creating PDF files is extremely easy by installing CUPS-PDF from the PCLinuxOS repository. CUPS-PDF installs as a print driver, so you can create a PDF file from virtually ANY program that you can print from. Just select the CUPS-PDF print driver, and select the "Print" button. (Pssst! Here's a tip ... create a directory named PDF in your /home directory, and CUPS-PDF will save all of your PDF files it creates to that directory. Otherwise, they will just pile up in your /home directory. This makes it much easier to find your PDF files later on.)
Other Ways To Create PDFs
Of course, it's a relatively trivial task these days to be able to create a PDF file from the Linux command line. In some cases, it's easier and faster to do from the command line than from a program with a full-blown GUI.
This is where pandoc comes in. The command line program, while not installed by default on a PCLinuxOS installation, is easily installed from the PCLinuxOS repository.
Here is the modest "help" text for pandoc:
Here's a description of pandoc from the man pandoc man page:
Pandoc is a Haskell library for converting from one markup format to another, and a command-line tool that uses this library.
Pandoc can convert between numerous markup and word processing formats, including, but not limited to, various flavors of Markdown, HTML, LaTeX and Word docx. For the full lists of input and output formats, see the --from and --to options below. Pandoc can also produce PDF output: see creating a PDF, below.
Pandoc's enhanced version of Markdown includes syntax for tables, definition lists, metadata blocks, footnotes, citations, math, and much more. See below under Pandoc's Markdown.
Pandoc has a modular design: it consists of a set of readers, which parse text in a given format and produce a native representation of the document (an abstract syntax tree or AST), and a set of writers, which convert this native representation into a target format. Thus, adding an input or output format requires only adding a reader or writer. Users can also run custom pandoc filters to modify the intermediate AST.
Because pandoc's intermediate representation of a document is less expressive than many of the formats it converts between, one should not expect perfect conversions between every format and every other. Pandoc attempts to preserve the structural elements of a document, but not formatting details such as margin size. And some document elements, such as complex tables, may not fit into pandoc's simple document model. While conversions from pandoc's Markdown to all formats aspire to be perfect, conversions from formats more expressive than pandoc's Markdown can be expected to be lossy.
In its simplest implementation, pandoc can create a PDF from a simple text file on your computer (with the *.txt file extension). As part of the release notices sent out every month for the magazine's release, we create a simple text file with all of the information that makes up the magazine's release notice.
So, as an example, I grabbed the release notice for the July 2022 issue of The PCLinuxOS Magazine. I went to the directory where I had it stored, and opened a terminal window for that particular directory.
I then entered the pandoc command as follows:
pandoc -o July-2022-Release-Notice.pdf July-2022-Release-Notice.txt
This tells pandoc that the output file (the "-o" command line option) will be the same as the input text file, but with the ".pdf" file extension. That is, we'll create the July-2022-Release-Notice.pdf file from the July-2022-Release-Notice.txt input file. For what it's worth, you can list multiple input files, separated by a space. This allows you to take multiple input files and create one PDF output file with the contents of all of the input files. Be aware that by just listing multiple input files, pandoc will just concatenate the second file right at the end of the first file, and the third file at the end of the second file, and so on. Pandoc will simply insert a blank line by default, before appending each subsequent input file to the end of the resulting PDF.
Screenshot of pandoc created PDF in qpdfview PDF reader.
Pandoc is a mighty little program. I've just illustrated its use in the simplest way possible. But pandoc is more. Much more. It is capable of outputting files in many different formats. Some of the more common output formats include Oo/LO ODT files, PDF files, HTML, Microsoft Word DOCX files, DocBook, DokuWiki, EPUB, FB2, JSON, LaTeX, MediaWiki, and man, to name a few. It can also convert between the various formats that it supports. In my testing, I was unable to trip up pandoc in its conversions, and it worked quickly and flawlessly. But for this article, we're going to restrict ourselves just to PDF files. If you want to know more about some of the other uses for pandoc, I recommend reading the pandoc man pages as a good starting point, by typing man pandoc at a command line prompt.
Pandoc uses a special markup language, called Markdown, for direction/instructions on how to create the output file. So, using the markdown language, you can specify what parts of a document you want displayed in bold print, italic print, and so forth. To complicate matters somewhat, there are several different "formats" or "dialects" of markdown. Fortunately, pandoc is also able to convert between many of these different markdown formats. Here is a good discussion of markdown to get you started, should your curiosity demand that you learn more about it. But, without the markdown code, pandoc will still create your new PDF document. Without the markdown code, your output will be a bit plain-jane, so that's one thing to keep in mind. But even then, it looks a LOT better than the even more plain-jane looking text file.
Finally, pandoc uses LaTeX to create PDFs. Thus, they tend to be fairly decent quality PDF files. Because it uses LaTeX, you will need to have a version of LaTeX installed on your computer. If you go to the PCLinuxOS repository to install pandoc, but don't have the requisite LaTeX packages installed (I didn't when I installed pandoc), they will be installed with pandoc as dependencies.
Summary
We often take them for granted. I think that's because they've become so prevalent in our computing world. But, where would we be without PDF files?
The PDF file format has a LOT of good things going for it. The first, of course, is its near universal portability between just about every computing platform out there (yes, there is even a PDF reader out there for DOS).
Second, PDF files use a tokenized PostScript language to retain the proper formatting of the document, while also embedding the fonts into the document. This ensures that no matter which platform a PDF file is viewed on, it will appear the same on all of them.
Third, PDF files are a bit more secure than just sending along a word processor document file, which can be altered with the greatest of ease. Can PDF files be edited? Yep, they sure can. But, it's generally not a trivial task to do, so many people won't even bother.
In upcoming articles, we'll take a deeper look at how to manipulate and edit PDF files. Some of these tasks utilize command line tools, while others use GUI programs. Along the way, we'll learn some new tips, tricks and tools for our Linux toolbox.
PCLinuxOS Recipe Corner:
Slow-Cooker Hamburger Hash
Serves: 12
INGREDIENTS:
3 pounds lean ground beef
1 can (15 ounces) tomato puree
1 can (10 3/4 ounces) condensed cream of mushroom soup
1 can (10 1/2 ounces) condensed French onion soup with beef stock
3/4 cup water
1 bag (28 ounces) frozen O'Brien potatoes with onions and peppers, thawed
4 medium carrots, diced (2 cups)
1 teaspoon salt
DIRECTIONS:
1 Cook beef in a 12-inch skillet over medium-high heat for about 10 minutes, stirring occasionally, until brown; drain.
2 Mix tomato puree and mushroom soup in a medium bowl. Stir in onion soup and water.
3 Spray 5- to 6-quart slow cooker with cooking spray. Reserve 1 cup of the potatoes. Gently mix beef, remaining potatoes, carrots, salt and soup mixture in the cooker. Sprinkle with reserved 1 cup potatoes.
4 Cover and cook on low heat setting for 8 to 9 hours or until vegetables are tender. Hash will hold on low heat setting up to 2 hours.
TIPS:
O'Brien potatoes are made of diced potatoes, chopped onions and pimientos. Sometimes red or green bell peppers are used in place of the pimientos. For tender potatoes, make sure to thaw them before adding to the slow cooker.
This recipe is a tried-and-true kid pleaser. Take it to Cub Scouts, Girl Scouts or school events, and there's little chance you'll have leftovers.
NUTRITION:
Calories: 395 Carbs: 24g Sodium: 950mg Fiber: 5g Protein: 26g
Inkscape Tutorial: Repeat An Object Around A Shape
by Meemaw
I watch GIMP and Inkscape tutorials on YouTube, and have found several really great ones! The guy from Logos by Nick is very good, and posted one about putting a shape around another shape. This is useful if you have a pattern you want to use in a curved border or around a circle. Let's look at it.
Start with a pattern or shape in Inkscape. I have a star I want to use for a flyer I'm making. I did an article similar to this in April, 2014, but we'll do a different project this time. Make sure that whatever you use (curves and shapes) can be changed to a path.
In Inkscape I'll draw the star and the rectangle I want to use. Then I'll change them both to paths using Path > Object to path. Select the rectangle, then click on Path > Path effects... and from the window that appears, choose the plus sign at the bottom to add an effect.
A new window will appear with all the path effects. Just as a reminder, the newer versions of Inkscape have this window. You can customize the window to show a list of effects or tiled icons (large or small). Mine is tiled with small icons. Choose Pattern Along Path.
The Path Effects window you had before will change to include all the settings:
The easiest way is to copy the object you want to repeat (in my case, it's the star). Then choose the rectangle, and click on the Paste Path icon, which is third to the right where it says Pattern Source towards the top of the window. When you click the icon, you will see your pattern appear.
Ooops! Did you get this? I forgot to warn you! Just under Pattern Source is Pattern Copies, and the default, at least on my Inkscape, is Single, Stretched. That means it takes one object and stretches it out over the whole path. Looks weird, doesn't it? OK, click on Undo (<CTRL> + Z). Change the copies to Repeated, Stretched and click your Paste Path again (you may have to copy the star again).
Ahhh, there's a border. On this one, you can see that the points on the stars are touching. If I don't want them that close together I can change the Spacing setting. In this one, I have changed the spacing to 3. You can actually change that without undoing this time.
Negative numbers are allowed as well. In this one, I used hexagons around an oval and set the spacing to -4. Notice that they overlap.
Many effects can be obtained simply by changing the path your object follows, and the settings you choose. Play with the settings until you get what you want. When you are happy with your creation, you simply finalize it by clicking Path > Object to path one more time.
When you've done that, you can actually edit your creation. I've done a red star border, and finalized it, but now I've decided that I just want a corner or two. Choosing Path > Break Apart, my border is separated into single stars, and I can delete or move those I don't want.
I chose the top half and moved it away. Then I chose the right half, flipped it, and moved it into the angle of the left.
To finish it off, I'm going to move/delete individual stars, duplicate and place a second corner, and finish my flyer.
In the video, Nick creates a garland of sorts - a leaf arrangement that can be part of an award - the same way I created the corners.
I'm also going to share some differences you can get in your pattern depending on the settings you choose. The settings are marked so you can see what's different. All of these are made with a leaf-like object around a circle. I also added an extra dark gray circle so you could see what and where the original path was.
Bill Gates' Evil Prophecy
by Alessandro Ebersol (Agent Smith)
In the 70's, the motto that propelled the then young company Microsoft was the one in the picture above: A computer on every desk, in every house, and running Microsoft software.
Well, after more than 40 years, this sad prophecy is about to come true, thanks to the Pluton chip, yet another attack on user freedom, perpetrated by one of the most abusive companies in existence.
But, what is the Pluton chip?
The Pluton chip was announced on November 17, 2020, on the Microsoft blog. The Pluton chip acts as an extension of the TPM (trusted platform module) platform. The trusted module platform, TPM, acts as a verifier on what the operating system can run, remote attestation, and other restrictions. The TPM module is usually a separate circuit, mounted on the computer's motherboard (although, over the years, several TPM implementations have emerged).
As the TPM module needs to communicate with the computer's CPU, the information that travels between the module and the CPU can be accessed, analyzed and reverse engineered with the information collected. Thus, it is possible to hack a TPM module. Then comes the Pluton chip.
According to Microsoft's blog post: "The Pluton project removes the potential for this communication channel (between the CPU and the TPM module) to be attacked by building security directly into the CPU." That is, the TPM module, with the Pluton chip, is inside the microprocessor. That is, it is a SOC inside the CPU, eliminating the external module entirely.
The Pluton chip is not new, in fact it has been used before
The Pluton project was introduced as part of the integrated hardware and security capabilities of the operating system in the Xbox One console released in 2013 by Microsoft in partnership with AMD and also within Azure sphere. In fact, what Microsoft intended with this project was to prevent modded Xboxes from entering the Xbox network blocking their access to Microsoft's network. The project worked so well that they decided to expand to microcomputers.
Block diagram of the Pluton chip
The concept of a security module that restricts the use of a computer is not unique to Microsoft. Apple also implements a similar technology, Secure Enclave, and Google, with Android, also implements SecureNet.
The reason behind Pluton is legit...
All the reasoning behind Pluton is legit. It is to ensure security in the internet of things (IoT), and it is correct to look for it. Because they are extremely frugal devices with no real processing power, they cannot afford to have sophisticated encryption and protection schemes.
To better understand the Pluton chip, it is necessary to know how Microsoft's cloud security scheme for IoT devices, Microsoft Azure Sphere, works.
The Microsoft Azure Sphere concept is based on the fact that the SOC processors that power the IoT devices that exist today can no longer be trusted. Because they are based on old technologies, they are not prepared for the security demands of a connected world. Microsoft has released a solution to address this problem, Azure Sphere. This Microsoft solution is now ready to go into production. Azure Sphere is a secure, high-end application platform with built-in communication and security capabilities for cross-industry IoT devices. The idea of Azure Sphere is to have a line of trust, from the IoT device to the Azure servers in the cloud.
This would be achieved through the integration of 3 elements, which work as one: a brand new security silicon chip (a microcontroller with Pluton technology already built in), the Azure Sphere OS operating system and the Azure Security Service. sphere. These components come together to create a chain of trust between the cloud and the devices.
The operating system Azure OS is Linux-like, and the microcontrollers are already starting to be produced by the Taiwanese company MediaTek.
MT3620 Azure Sphere Chip Architecture
The road to hell...
As the saying goes, the road to hell is paved with good intentions, and despite a legitimate concern for internet security, in the age of connected devices, this "security" opens up an avenue of possibilities for Microsoft to abuse again, the market, users and laws (let's face it, the laws are not yet ready for our new digital age).
Now, what could go wrong? All, let's recall an interesting case in which Microsoft, even indirectly, abused its customers.
Stuxnet, or How Windows Helped Bring Down Iranian Nuclear Power Plants
Stuxnet is a computer worm specifically designed to attack the SCADA operating system developed by Siemens and used to control Iranian uranium enrichment centrifuges. It was discovered in June 2010 by the Belarusian antivirus company VirusBlokAda. It is the first worm discovered that spies on and reprograms industrial systems. It was specifically written to attack the SCADA industrial control system, used to control and monitor industrial processes. Stuxnet is able to reprogram PLCs and hide the changes.
Stuxnet's design and architecture are not domain specific and could be adapted as a platform to attack modern SCADA and PLC systems (e.g. in factory assembly lines or power plants).
Later, and with the help of Edward Snowden's revelations, it emerged that Stuxnet was part of an espionage and cyber warfare program called Operation Olympic Games (Operation Olympic Games was a covert and still unrecognized campaign of sabotage through of cyber nuisances, directed at Iranian nuclear facilities, likely by the United States and Israel. As reported, it is one of the first known uses of offensive cyber weapons. Initiated under the George W. Bush administration in 2006, the Olympic Games were accelerated under the Obama presidency, which heeded Bush's advice to continue cyberattacks on Iranian nuclear facilities at Natanz. Bush believed the strategy was the only way to prevent a conventional Israeli attack on Iranian nuclear facilities).
David Emm, a senior security researcher at Kaspersky Labs, told the Guardian: "We think the sophistication, purpose and intelligence of Stuxnet suggest the involvement of a state.
"This is a very sophisticated attack - the first of its kind - and was clearly developed by a group of highly qualified people with the intention of gaining access to SCADA [Supervisory Control and Data Acquisition] systems - industrial control systems to monitor and manage industrial infrastructure or facility-based processes. In contrast to most indiscriminate cybercrime threats on the Internet, this one has been targeted at very specific targets. It is also different because there is no obvious financial motivation behind the attack - the objective appears to be sabotage of systems." What is known is that Stuxnet was created to exploit zero-day flaws that had not been made public. Windows flaws. And given Microsoft's promiscuity with government agencies, it is not impossible that the entire map to be able to launch this attack has been provided by Microsoft itself. Of course, the company was never connected to this act of digital vandalism, but the last time I checked, 2+2 was 4...
Well, you reader, you might be thinking: F@#$! the Iranians. They're a bunch of crazy fanatics, they better be sabotaged anyway. But once you open Pandora's box, everyone can be affected.
The legacy of Stuxnet
As I wrote above, once you open the door to malware, it gets loose and will damage the systems it encounters, no matter if they are allies or enemies. After all, as everyone remembers, both Saddam Hussein and Osama Bin Laden were CIA assets, trained and funded by the US government. But Stuxnet left us a legacy, its code continues to be studied, and, of course, it had heirs...
Duqu
In 2011, threat analysts discovered a new worm and named it Duqu. The striking similarities between Duqu and Stuxnet led experts to believe that the two malware strains were closely related. In fact, they were almost identical: the only difference is that Duqu was not designed to sabotage machines, but to act like spyware by capturing keystrokes and collecting system data.
Flame
An even more suspected Stuxnet-linked malware that emerged in 2012. Dubbing the new threat Flame, researchers found that the virus shared much of its code with Stuxnet, in particular the way it was designed to target the same vulnerabilities of Windows and propagate through USB storage devices.
But, why did I bring this case? Well, now, let the imagination fly, and see how, with the help of Microsoft, a tyrannical government can control its entire population, through its digital devices...
Brave New World
In the not too distant future, the following could be possible with Pluton (with some custom application development to streamline everything together):
Now, in our imagination exercise, visualize a hypothetical scenario. A user in Legal creates a document. When the user uploads it, Azure checks it against Pluton to verify that the document is likely clean and also to firmly establish who created it. When another user wants to download the document, Azure only provides a version that was encrypted with the user's Pluton public key if that user belonged to the correct department and therefore can only be read by that user.
Now, multiply this hypothetical scenario all over the world, and everyone who uses Windows applications will never have any secrets. It would be the end for privacy and anonymity. Everything you do will have to be validated by a server in the Azure cloud, and, of course, big brother will watch. Ever. Using computers will be something like being a Linux user from North Korea.
Other than that, with a dedicated chip running inside the microprocessor, what else won't it do? Will it not send my activities in forums, to some government agency? Or my emails? Or my comments on Facebook? The possibilities are endless, for evil, unfortunately.
The implications are already starting to show
At the beginning of the year, Matthew Garrett, the researcher who created the UEFI bootloader for Linux (which I do not agree with at all, as it sets a precedent for Microsoft to abuse the market, with its position of power, should not be allowed under any circumstances) said that the Pluton chip was not an attack on users' freedom to use whatever operating system they wanted, which was not a threat.
In July 2022, he recanted, when he was unable to install Linux on a high-end Thinkpad Z13, complaining that this was not a legal practice by Lenovo.
But, that's what Microsoft wants. Under the guise of enforcing security, it blocks the machine's access to the user himself, being the gatekeeper of personal computing. In other words, "my" microcomputer is over. From now on, it will be Microsoft's microcomputer, and only what it allows will run...
How to prevent that from happening?
It is up to us, the users, to boycott AMD products that contain the Pluton chip, to favor recycled or refurbished computers. And there is still more to do:
So folks, things have never been so in jeopardy as they are today. Microsoft wants to be the big brother, and dictate what everyone can run on their computers, under the benevolent guise of ensuring security. We can't afford that, or the future of personal computing and privacy will be ruined.
Finally, let's not forget that anyone who says they don't need privacy because they have nothing to hide is the same thing as not defending freedom of speech, because they have nothing to say...
Let's fight this! The scenario is ugly, and the battle will be hard!
Short Topix: Removal Of Obsolete AMD Fix Speeds Up Kernel
by Paul Arnote (parnote)
Monthly Update: Assault On Your Privacy
MODERNLOADER HAS BEEN DISCOVERED TO BE DELIVERING SEVERAL MALWARE PAYLOADS, according to an article from The Hacker News. Thought to be propagated by Russian threat actors using off-the-shelf "tools," it is designed to provide attackers with remote control over the victim's machine, which enables the adversaries to deploy additional malware, steal sensitive information, or even ensnare the computer in a botnet.
ONE OF THE MORE POPULAR PDF READERS ON THE GOOGLE PLAY STORE HAS TURNED OUT TO BE NOTHING MORE THAN A VEHICLE TO DELIVER potentially harmful adware to its unsuspecting users, according to a blog post from Malwarebytes Lab. Creatively called "PDF reader - documents reader," it does nothing at first, lying in wait until a certain amount of time has elapsed. Then, it starts displaying full-screen ads that cannot be bypassed unless the user clicks on the ad. It continues displaying disruptive ads with increasing frequency, even when the app is not in use. The app has had over 1,000,000 downloads/installations.
GOOGLE RELEASED CHROME 105.0.5195.102 TO FIX THE SIXTH ZERO-DAY SECURITY ISSUE this year for Linux, MacOS and Windows users, according to multiple computer news outlets, including this article from BleepingComputer. The exploit is described as being readily available/exploitable in the wild. Labeled CVE-2022-307, details about the specific vulnerability were withheld to give time for sufficient Chrome users to update to the patched version of the beleaguered browser.
SHIKITEGA, A NEW STEALTHY MALWARE FOR LINUX has been discovered infecting computers and IoT devices, according to an article on BleepingComputer. This new malware uses a polymorphic encoder, and performs its "deeds" in a multi-stage manner. Downloading only about 350 bytes at a time, it is easily evading detection. The payloads install themselves as crontab entries, making it self-propagating. The new vulnerability was discovered by researchers at AT&T. They are uncertain of the initial delivery method.
RANSOMWARE GANGS ARE SWITCHING UP TACTICS, according to an article on BleepingComputer. Instead of encrypting entire files, they are switching to using an intermittent encryption method. By simply encrypting part of a file (instead of an entire file), the file is rendered unreadable until/unless the ransom is paid for the code to unencrypt the data. Plus, the data can be encrypted faster by just encrypting portions of the file, versus the entire file.
FISHPIG, a UK-based maker of e-commerce software used by as many as 200,000 websites, is urging customers to reinstall or update all existing program extensions after discovering a SECURITY BREACH OF ITS DISTRIBUTION SERVER THAT ALLOWED CRIMINALS TO SURREPTITIOUSLY BACKDOOR CUSTOMER SYSTEMS, according to an article on ArsTechnica.
A novel phishing campaign is underway, targeting Greeks with PHISHING SITES THAT MIMIC THE STATE'S OFFICIAL TAX REFUND PLATFORM AND STEAL CREDENTIALS AS THEY TYPE THEM, according to an article on BleepingComputer.
LAZARUS, A NORTH KOREAN CYBERESPIONAGE GROUP, KEEPS HITTING ENERGY PROVIDERS IN THE U.S., CANADA AND JAPAN WITH A NEW MALWARE ARSENAL, according to an article from TechRepublic. The state-sponsored hackers are also known as Hidden Cobra or Zinc.
The otto-js Research Team published an article outlining how users using GOOGLE CHROME OR MICROSOFT EDGE'S ENHANCED SPELLING FEATURES MAY BE UNKNOWINGLY TRANSMITTING PASSWORDS AND PERSONALLY IDENTIFIABLE INFORMATION (PII) TO THIRD-PARTY CLOUD-BASED SERVERS.
Voyager 1's Mysterious Glitch Begets Another Mystery
For much of the past year, Voyager 1, from 14.7 billion miles away from Earth in interstellar space, has sent gobbledy-gook telemetry data back to Earth. As one of only two man-made objects to ever leave our solar system and continue on into interstellar space (the other one is its sister craft, Voyager 2), engineers at NASA's Jet Propulsion Laboratory (JPL) had to take some time to figure out what exactly was happening. Launched in 1977, the Voyager 1 mission has last far longer than anyone ever expected. You can view the Voyager mission page here.
According to a report from JPL, the probe's attitude articulation and control system (AACS), which keeps Voyager 1's antenna pointed at Earth, began sending garbled information about its health and activities to mission controllers, despite operating normally. The rest of the probe also appeared healthy as it continued to gather and return science data.
The JPL news release continued:
The team has since located the source of the garbled information: The AACS had started sending the telemetry data through an onboard computer known to have stopped working years ago, and the computer corrupted the information.
Suzanne Dodd, Voyager's project manager, said that when they suspected this was the issue, they opted to try a low-risk solution: commanding the AACS to resume sending the data to the right computer.
Engineers don't yet know why the AACS started routing telemetry data to the incorrect computer, but it likely received a faulty command generated by another onboard computer. If that's the case, it would indicate there is an issue somewhere else on the spacecraft. The team will continue to search for that underlying issue, but they don't think it is a threat to the long-term health of Voyager 1.
"We're happy to have the telemetry back," said Dodd. "We'll do a full memory readout of the AACS and look at everything it's been doing. That will help us try to diagnose the problem that caused the telemetry issue in the first place. So we're cautiously optimistic, but we still have more investigating to do."
Voyager 1 and Voyager 2 have been exploring our solar system for 45 years. Both probes are now in interstellar space, the region outside the heliopause, or the bubble of energetic particles and magnetic fields from the Sun.
Removal Of Obsolete AMD Fix Speeds Up Kernel
Back in 1996, APM (Advanced Power Management) was replaced by ACPI (Advanced Configuration and Power Interface). Linux did not gain ACPI support until 2002. ACPI was originally developed by Intel, Microsoft and Toshiba, with HP, Huawei and Phoenix joining the development at a later date.
Back in 2002, to improve compatibility between Intel and certain AMD chips (remember the Athlon chips?), a special instruction set was added to the Linux kernel for AMD chips. It caused the processor to briefly stop/pause processing instructions, presumably to keep ACPI in "sync." However, the new AMD chips no longer require this intervention ... but it's still there. Or, at least it was.
According to an article on The Register, Intel's Dave Hansen issued a patch that limits the instruction set to Intel CPUs only, since they use a different method to pause the CPU than AMD CPUs use. The new patch should be available when the Linux 6.0 kernel is released on October 2, 2022.
EXCEPT ... PCLinuxOS users won't have to wait for the 6.0 kernel to appear. Texstar has applied the patch to the 5.19.12 kernel, and plans to also apply it to the LTS 5.15.71 kernel.
Don't expect to see huge speed increases on AMD processors. Many of the AMD processors currently in use are faster than their 20-year-old predecessors, so desktop computing speeds are expected to be minimally affected, with little to no noticeable difference in speeds. Early reports indicate that the most noticeable differences are in a quicker boot time, and large programs at least appear to be launching a tad quicker.
USB4 Standard To Be Published November 2022
Just as you were getting used to USB3 (specifically, the USB 3.2 2x2 standard), the USB-IF is planning on releasing the specs for the new USB4 in November, 2022, according to an article on ArsTechnica.
The new standard pretty much ditches the USB-B connector all together, and is keen on phasing out the much more common USB-A connector. The USB-IF hopes to replace them both with the smaller and faster USB-C connector.
USB4 will support minimum data rates of 20 Gbps, but can support 40Gbps data rates. The new standard will also dynamically allocate bandwidth. So, if your streaming video (connected, say, to a USB4 hub that is attached to your TV and an external hard drive), the bandwidth will be allocated to each dynamically, based on need. The older USB3.2 standard just split the bandwidth in half, and each device could only access that predetermined amount of bandwidth.
I wouldn't run out right away to get USB4 cables and peripherals. Even the USB-IF acknowledges that it typically takes 12 to 18 months to see any new devices sufficiently populate the computer peripheral market following the announcement of a new standard. And as for those USB-B and USB-A cables and peripherals? I think I'd hang on to them for the time being. Older equipment (which many Linux users tend to use, since they can acquire them cheaply) will not have the USB4 (and maybe not even the USB3.2) standard. All of those USB2 and USB1 devices aren't just going to "disappear," either. I suspect that there will be many of those latter two categories of USB devices around for quite some time to come. Scanners and printers that use the USB-B connector are still widely available on the used market, as well. So, there's still going to be plenty of uses for those older style cables for the foreseeable future.
PCLinuxOS Magazine Short Topix Roundup
THE JAMES A. WEBB SPACE TELESCOPE has just captured the first live image of a planet located outside of our own solar system, according to an article on CBS News.
In some jurisdictions (like the EU), users have to consent to tracking. This has resulted in many websites interrupting the flow of viewing a page by stopping to ask for permission for tracking cookies. Well, THE DEVELOPER OF THE "I DON'T CARE ABOUT COOKIES" BROWSER EXTENSION (which bypasses all of those "permission" popups), HAS SOLD HIS EXTENSION TO AVAST for an undisclosed amount of money, according to an article on ArsTechnica. Yes, the same company that puts out the (in)famous (depending on your point of view) antivirus software. Users are up in arms, since Avast has, as recently as 2019, been caught harvesting user data with another browser extension. Avast has attempted to put the fears to rest, publicly stating that those days are in the past, and that Avast currently does not collect any user data.
SUPER-EARTHS ARE BIGGER, MORE COMMON AND MORE HABITABLE THAN EARTH ITSELF -- AND ASTRONOMERS ARE DISCOVERING MORE OF THE BILLIONS THEY THINK ARE OUT THERE, according to an article on The Conversation website.
Do you have an old smartphone just laying around? Unsure what to do with it? Well, an article on The Atlantic has some GOOD WAYS TO REPURPOSE YOUR OLD SMARTPHONES. Some of the suggestions include repurposing the old phone as a webcam or as a dedicated music player.
Rolling Stone magazine has released its list of the TOP 100 GREATEST TV SHOWS OF ALL TIME. What's more interesting than what's on that list is what shows were NOT on the list. There isn't much information on the criteria used to select the shows that populate the list, so we're left to wonder if this is merely one person's opinion piece.
Testimonial: A Convert And Newbie
by lonewolf
It doesn't appear a lot of folks wanted to announce themselves. I guess I'll be the odd duck out here. I just wanted to say hey to everybody. I've been running ONLY Linux on my personal computers for 20 years or so. I converted my wife about 15 years ago. She now uses Linux on her home computer, but still has to use a Windows PC at work. Just ask her what she thinks and you'll get an earful about having to reboot the work computer 5 or 6 times a day. The good news is that she has finally decided to retire in a couple of months so I won't be hearing her complain about that.
I ran PCLinuxOS a lot of years ago, but got away from it for whatever reason. I've run Debian/Ubuntu/Mint distros or their derivatives for a lot of years now. I began having some issues and wasn't getting a lot of them resolved on the various forums. I'm not sure what has changed, but I recently decided to do a lot of distro shopping and hopping to see if I could come up with something better. I was kind of disappointed when I was unable to get their latest releases installed on any of my laptops. Every distro I tried gave me some sort of fit when I tried the install. I had never had trouble like that in the last 10 years and was getting really frustrated.
I decided to look for any distro that is NOT a derivative of that family. I also was looking for a non-systemd distro, and I prefer XFCE. Yep, up jumped PCLinuxOS. I decided to give it a whirl. I was really frustrated trying to get PCLinuxOS installed. The problem I was having was in partitioning my hard drive to suit PCLinuxOS. I was still partitioning for the distros I had been running. I don't use UEFI and I still use a DVD for the installation media. Yeah, I know, I'm a dinosaur.
Anyway, it finally hit me yesterday to allow PCLinuxOS to take over the entire hard drive on one of my spare laptops and set the partitions as needed. WOW! No wonder I couldn't get things to work using my old partitioning. I always had a linux-swap partition set and lately I had been using 8 GB for that. Then I had a 25 GB partition for the OS and the rest of the drive for my Home directory. And sure enough, after letting PCLinuxOS do its own thing, on reboot I had a running PCLinuxOS system. When I looked at the partitioning in Gparted, it became perfectly clear why I could not get a system to boot after the install. LOL!
I've run into a couple of really minor glitches (so I thought) that I managed to get ironed out with a little research. For instance, I like and use Simple Screen Recorder to record performing certain tasks, then I upload the videos for my old customers and friends/family to see. I found that it is as easy as trying to use a remote desktop. When I searched for simplescreenrecorder I was disappointed to see it was not on the list of packages available to me. I think it was on the second site I found when doing a search for possible screen capture apps that I saw a mention of "ssr". I went immediately to Synaptic and searched for ssr. Now, I'm a happy guy.
So, I'm here to stay since I had so much trouble with the other guys' distros. But, I do have one question to put out here. I'm a little tentative to bring it up after what happened to me on another forum. I use, and have used for about ten years, Bleachbit to clean things up occasionally. I asked for assistance in doing a certain thing relating to Bleachbit and instead of suggestions I was hit with comments like, "Only an idiot would use a wrecking ball on his own system" and "If you're stupid enough to use a piece of crap like that you don't deserve help". Now, keep in mind that was on one of the largest Linux distro forums on the 'Net. To say I was shocked would be an understatement. So, I responded saying that if you don't have suggestions or advice to help me, please stay off my thread. I further stated that I had used Bleachbit for ten years without a problem and then added that if somebody else DID have a problem, then it might be that they weren't using the program correctly. I ended up having my thread killed and then I was notified my account was being deleted. Yep, they did. I no longer have access to that forum.
So, without causing a ruckus on here, I will have a question about Bleachbit to pose over on the correct board. BUT, before I do that, I'll ask. Is Bleachbit a sore subject on this forum? If I ask my question will I get possible solutions or will I be bombarded with negative comments about Bleachbit. Considering it is included with PCLOS by default, I'm hoping I can finally get some help.
I know for a fact I'll have many questions as I tweak and use PCLinuxOS. So far I'm impressed with the quickness and stability and the limited use of resources to present the desktop. Right now I'm showing just over 900 MB of memory used and I have my browser opened along with a terminal window. That is about 500 to 600 MB less than the previous distro. Pretty impressive!
I look forward to chatting with you guys as time goes by.
Good Words, Good Deeds, Good News
compiled by Meemaw
Dexter the Bipedal Dog
Dexter, a Brittany Spaniel in Ouray, California, lost one of his front legs in an accident when he was just a puppy. Since then, he has learned to overcome his loss in a very different way.
His owner, Kentee, after leaving him at the bottom of the porch stairs one day, discovered that he could climb to the top of the stairs on his own: NOT by crawling with three legs, but by using his back legs and stepping up the stairs like his owner.
Kentee takes him on walks all the time (Brittanys need lots of exercise), and he has gotten fairly famous for his different way of getting around. According to the American Kennel Club's website, "Bright and eager at home, and tireless afield, Brittanys require a lot of exercises, preferably with their favorite humans. Brittanys are smaller than setters but leggier than spaniels, standing about 20 inches at the shoulder. Their beautiful, boldly patterned coat comes in combinations of white and vivid orange and liver (reddish-brown). They are rugged and strong but smooth, clean, and quick afoot."
He goes to the vet regularly, to make sure he's in good shape, and has been in several parades.
Elderly Man Found in Retention Pond
In Orange County, Florida, Dan had left home without his medication and got into a little trouble. He had been missing since the previous day. The police had been summoned and Sheriff's Deputy Jones was searching along with others. Jones spotted the 81 year-old man in a pond and he and another officer pulled him out. He was soaking wet, but seemed to be alright.
First responders arrived and took the man to the hospital. The Sheriff's office had a clip from the officer's body cam that they posted on Twitter. The public response was overwhelming, praising the officer for rescuing the man.
At the Children's Hospital in Louisville, Kentucky, everyone helps to lift the patients' spirits, including some particular people. Pro-Clean International, a local window-washing company, started about five years ago dressing up as Santa Clause and elves during the Christmas season. Now they dress up whenever they are at the hospital - as superheroes.
In July, they arrived to wash the windows and the kids got a surprise. "The window cleaners were dressed as iconic characters from comic books and movies, such as Iron Man, Batman, Deadpool, and Superman, plus other heroes."
The Tom Moore Cave System in Perry County, Missouri, is a 22 mile-long cave system that groups like to explore. In mid-August, a group was exploring and came upon a dog, huddled in the darkness. She was alive, but wouldn't move or get up for anyone.
Gerry, one of the explorers, volunteered to go back to the surface and try to recruit more help, and also started going door-to-door to try to find the dog's owner. A man named Jeff appeared at the cave after hearing that someone may have found his dog, who had been missing for nearly two months. When he heard the dog's description, he was sure it was his dog, 13 year-old Abby.
She allowed them to put her in a duffle bag and be carried to the surface, a trip that also involved a lift through a tight, vertical passageway. She was totally cooperative. It is unknown how she got down there, but the thought was that the cave flooded during the last rain and she got swept along in the current. Jeff reports that she is doing well now.
Man Creates Benches At Bus Stops
James rides the bus on a regular basis in Denver, Colorado. After riding the bus and seeing the same problem at several stops, he realized that the bus passengers were sitting on the ground waiting for the bus - because there was no place to sit at the bus stop. "For people to have to sit in the dirt while they're waiting for a bus is just undignified," said the young man, who works with the Colorado Workforce Development Council.
James took action. He started building benches to place at the bus stops. There are thousands of bus stops in Denver, but he didn't let that deter him. He's made eight so far, and now people have stepped up to help. Each of James' benches is carved with the same message, "Be Kind"
A Twitter post states, "This is James. He noticed that bus stops in his neighborhood didn't have any benches and people would often sit on the ground. So he went around, collected scrap wood, and started making free benches. He's already installed eight so far."
Boy Always Dreamed Of Owning His Own Farm
Eight year-old John-Luke has always dreamed of owning a farm. When he moved to a rural property in Pennsylvania, he was hoping he could grow enough to have a produce stand, using some of the food from his grandmother's garden nearby. Unfortunately, one of their goats, Lucky, had other plans for the vegetables, destroying most of his grandmother's garden and eating his acquisitions.
That didn't deter John-Luke. He still has the produce stand, using what he can from his grandmother's garden, but he also goes to the Snyder County Produce Auction to get the rest. He likes to grow sunflowers and pumpkins, but his customers are also interested in cantaloupe and zucchini. He goes to the auction early on Mondays to get the freshest produce. He also likes to add an exotic twist to his selection when he can. "I try to get the colorful cauliflower or the Roman cauliflower," he says. He pretty much runs everything on his own and helps feed the community through his farm stand, where he offers items such as zucchini bread and relish made with ingredients from his garden.
He's still saving for a farm!
Protect Your Inbox: DuckDuckGo Email Protection Beta Now Open To All
by Omid Majdi
DuckDuckGo Blog
Reprinted with permission
Email Protection beta makes it easy for you to get your very own @duck.com email address!
Why Block Email Trackers or Hide Your Email Address?
Have you ever entered your email for a loyalty program or coupon and started getting emails from companies you didn't subscribe to? Or noticed ads following you around after clicking on an email link? You're not alone! There are multiple ways companies can use your email to track you, target you with ads, and influence what you see online. They can even share your personal information with third parties -- all without your knowledge.
Companies embed trackers in images and links within email messages, letting them collect information like when you've opened a message, where you were when you opened it, and what device you were using. In our closed Email Protection beta, we found that approximately 85% of beta testers' emails contained hidden email trackers! Very sneaky. Companies can use this information to build a profile about you.
Email trackers can collect information like when you've opened a message, where you were when you opened it, and what device you were using.
And because your email addresses are connected to so much of what you do online -- making purchases, using social media, and more -- tracking companies can also effectively use your personal email address as a profiling identifier. In fact, many companies are so hungry for your personal email address that they'll actually pull it from online forms you haven't even submitted yet! Beyond sending you more emails, companies often upload your email address to Facebook and Google to target you with creepy ads across apps and websites.
Reintroducing DuckDuckGo Email Protection (Beta)
DuckDuckGo Email Protection is a free email forwarding service that removes multiple types of hidden email trackers and lets you create unlimited unique private email addresses on the fly. You can use Email Protection with your current email provider and app -- no need to update your contacts or juggle multiple accounts. Email Protection works seamlessly in the background to deliver your more-private emails right to your inbox.
In our closed Email Protection beta, we found that approximately 85% of beta testers' emails contained hidden email trackers.
Signing up for Email Protection gives you the ability to create Duck Addresses. There are two types that help protect your email privacy:
Many users have loved the Email Protection beta so far, with millions of more-private emails being forwarded weekly. It's email privacy, simplified -- and we're thrilled to open the beta for everyone to try it out!
Updates to DuckDuckGo Email Protection
Since launching DuckDuckGo Email Protection into private waitlist beta, we've been continuously making improvements based on feedback.
Link Tracking Protection: In addition to blocking trackers in images, scripts, and other media directly embedded in emails, we can now detect and remove a growing number of the trackers embedded in email links.
Smarter Encryption: We've started using the same Smarter Encryption (HTTPS Upgrading) that's at work in our search engine and apps to upgrade insecure (unencrypted, HTTP) links in emails to secure (encrypted, HTTPS) links when they're on our upgradable list.
This is Link Tracking Protection and Smarter Encryption in action!
Replying from your Duck Addresses: You can now reply to emails from all your Duck Addresses. When you get an email to a Duck Address, you can just hit 'Reply' type your message, and send it off. Your email will then be delivered from your Duck Address instead of your personal address.
Self-Service Dashboard: Want to update your forwarding address? Or even delete your account? You can now make changes to your Duck account whenever you want, saving you time and effort.
Our new self-service dashboard makes it easier for you to make changes to your Duck Address.
How People are Using Email Protection
Wondering how this feature works in the real world? Here's what our beta testers had to say:
Getting Started
Email Protection is supported in the DuckDuckGo Privacy Browser for iOS and Android, DuckDuckGo for Mac (beta), and DuckDuckGo Privacy Essentials browser extensions for Firefox, Chrome, Edge, and Brave.
Once you follow the steps to create your Personal Duck Address, you're all set to start using it right away! And while browsing, look for Dax the Duck (our mascot) to help you autofill your Personal Duck Address or generate a Private Duck Address for you on the fly.
Like all our features, DuckDuckGo Email Protection will never track you. We believe that your emails are none of our business! When your Duck Addresses receive an email, we immediately apply our tracking protections and then forward it to you, never saving it on our systems. Sender information, subject lines...we don't track any of it. (Learn more in our Privacy Guarantees)
Additionally, we are committed to Email Protection for the long term, so you can feel confident about using your Duck Addresses. During the private beta, we've been shoring up our backend systems to support millions of users. And as we move out of beta, we'll also be incorporating our email tracker dataset into our open source Tracker Radar.
So give Email Protection a try and let us know what you think! We look forward to helping you protect your inbox.
PCLinuxOS Recipe Corner Bonus:
Spicy Lemon Chicken Pasta with Tomatoes
Serves: 4
INGREDIENTS:
1 pound chicken breasts
2 Tbsp olive oil
1/2 cup diced yellow onion
1 Tbsp minced garlic
8 oz (about 2 1/2 cups) small, dry pasta
1 cup grape tomatoes, halved
2 cups chicken broth
Juice from one large or two small lemons
1 cup water
1 tsp dried basil
1 tsp salt
1/4 tsp red pepper flakes
1/2 tsp pepper
1 cup shredded Mozzarella
DIRECTIONS:
Heat olive oil in a large skillet over medium-high heat. Add onion and stir, cooking until soft and nearly translucent. Stir in garlic and cook for 30 seconds. Add chicken and cook until just browned.
Stir in the pasta, tomatoes, chicken broth, lemon juice, water, basil, red pepper flakes, salt and pepper. Bring to a boil and continue to stir often, uncovered, for about nine minutes, or until most of the liquid has evaporated.
Remove from heat, sprinkle cheese on top, and cover for ten minutes or until cheese is melted and remaining liquid is absorbed.
NUTRITION:
Calories: 500 Carbs: 48g Sodium: 1335mg Fiber: 3g Protein: 40g
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